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Preferred shopper     

About the application  

Logivision is a corporation specialized in the development of software for the retail industry with a particular focus 
on operation systems for front-end terminals. Innovative and always at the forefront of new technological 
developments, Logivision is committed to improving the service and products we provide to our customers.   

Preferred shopper overview  

The preferred shopper software allows you to create customers and set up features to reward your customers. By 
using the PS module you will be able to determine sales by customer to the item level. System features include:  

 

Unlimited customer records 

 

Multiple customer contact records per account allow purchase reports for one account to show details for 
different contacts (as for a family using a common account) 

 

Price level per customer type 

 

Discount percentage by customer type 

 

Discount table with discount by customer level by sub-department link 

 

Cost-plus by shopper level 

 

Item tracking by customer 

 

Points tracking 

 

Accounts can be created from front-end terminals 

 

Customer picture can be scanned for display on front-end terminals.  

Note: A working knowledge of the L-BOSS system and the L-POS system are pre-requisites to attending the PS 
class. 
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Navigating the L-BOSS Application   

Using the mouse  

Throughout the L-BOSS application you will find drop down menus and main screen icon groups to navigate 
through the program or launch utilities. The most commonly used drop down menu options have been included as 
buttons on the L-BOSS desktop to facilitate access. In other words, some drop down menu options lead to the 
same location as clicking that option's icon counterpart.   

Not all options have buttons, and must be launched from the drop down menu. Options that are not often required, 
or single use setup tools (used to configure the system at installation time) do not have main screen buttons. If an 
option does not appear to have an button, use the drop down menus to locate and launch that option.  

Using the keyboard  

As with most Windows style applications, the drop down menu titles and options are also accessible using the 
keyboard. This can actually be faster than navigating with the mouse, after you've memorized the keystrokes 
involved for a specific task. The keystrokes associated with menu titles and options are underlined. For example, 
the "File" menu has an underscore under the "F": 
Hold down the [Alt] key on the keyboard. 
Simultaneously, press the [F] key. 
The File menu opens.   

The options in the drop down menus also have underscored letters. Once a drop down menu is open, you can 
press the letter that is associated with the option you wish to launch. You can also use the [up] or [down] arrow 
keys to select the menu option, and then press [Enter] to launch the option.  

Within applications or utilities, the [Tab] key will move the cursor from one box, window or editable field to the next, 
in a pre-set order. Holding down the [Shift] key and pressing the [Tab] key will reverse the pre-set order. Once the 
cursor is on an option, press the [Enter] key to launch the option.  

Understanding Communications  

While the network is "down" and L-BOSS cannot communicate with the front end no customer account balances 
will be available until the system returns to normal, but the L-POS front end station will prompt the cashier with a 
"server not available - continue anyway?" error message. At this point it is up to the store manager to allow or not 
allow account charges during a network down.  

Backups Are Important!  

Is your sales information important? Is your database important? Is your hardware setup important? The answer is 
always YES! What happens if the system crashes? How can I protect my information? Like any "mission critical" 
information, your L-BOSS installation should be archived on a regular basis. Normally, your Logivision dealer will 
suggest ways to protect your information, based on the type of installation you have, and how much space your 
data actually takes up. In most situations, you'll want to backup every night, (or other time when the system is not 
busy). 



L-BOSS Preferred shopper       

6        

Setting up the L-BOSS Preferred shopper program  

The preferred shopper option must be enabled on the license key before you can use it. If your license does not 
include the PS option, contact your reseller.  

In order to use a customer account on the POS you need to complete several steps.  

 

Create risk levels 

 

Create shopper levels 

 

Create client records (accounts) 

 

Create client contact record(s) for each account 

 

Send the records to the POS terminals 

 

Points issuing 

 

Account settings in PosSetup 

 

Set up the POS keyboard or touch screen with an account button. 

 

Set up the scanner definition table to scan account cards  

  

Note: This manual related to the use of accounts with the Preferred shopper module.   

From the L-BOSS main menu 
open the Maintenance program.  

The preferred shopper module   
and the accounts receivable 
module use the same customer 
information from the database.   

The preferred shopper option is 
required to use points or the 
discount table. The accounts 
receivable option is required to 
post house charges.  

The same account file is also 
used for positive or negative 
check verification.  
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Opening the account tables  

L-BOSS allows you to create customer records for check cashing, store charges and customer demographics. The 
customer maintenance is accessed using the Maintenance application's "Account" menu, "Customer" option, or the 
"Clients" desktop icon. Each account created must have a link to a customer risk level, and to a client level 
(shopper privilege level). It is good practice to define the related customer tables before adding customers. Note 
that the terms "customer" and "client" are interchangeable.  

From the maintenance application, the Account menu includes the following menu:  

 

Use the required option to access the tables you want to 
program: 

 

Customer is the main account file 

 

Client level is to create shopper privilege levels 

 

Risk level is to manage AR credit balance and check 
spending or check cashing privileges 

 

Account view is a convenient way to open all 3 
account related tables 

 

Discount accesses the preferred shopper discount 
table (a licensed option for preferred shopper is required) 

 

Custom messages allow you to modify messages that 
appear on account statements. 
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File menu  

The Maintenance application's "File" menu contains common options such as login / logout, language setting etc., 
but is also dynamic. Depending on the table being edited, the options in the "File" menu change to include utilities 
designed to test or verify system integrity for the selected data type. For example, it is important to complete the 

set-up of accounts that were created on the POS 
terminals directly.  

 

Show modified by registers will display a list of the customer 
records that were created or changed on the front end terminals during 
a transaction. This option is programmable and may not be available 
on your system. 

 

The Send to host option of the "File" menu options is only available 
when the Host active option is selected to return data to a headquarter 
system. The "send to host" option will output the changes made on the 
local L-BOSS machine back to a host system. This means that 
changes to prices, accounts and other files can be made at a store and 
sent back up to the host system. Select this option for the tables that 
may be edited locally in a store. When this option is selected for any 
item in a table it means that any change made to any record in that 
table will be returned to host. For example, you cannot send item 1 to 
host but not send item 2. If Send to host is selected when you are 
editing PLU's, all PLU changes will return to host. Please consider as 
well that changes sent back up to the headquarter system will be 
deployed to all terminals that are part of the same target group for that 
file type. This means that if a price is changed at store 3 and all stores 
share the information on that product, the change will make it to the 
other stores in the next communication cycle. 
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Editing tools  

Regardless of which data table you edit, the Maintenance application provides a common set of tools on a toolbar 
at the top of the data table editor. The Maintenance main menus change as well, depending on the table you are 
programming. The toolbar is common to all tables you edit.  

   

Apply changes tool allows you to post the changes to the record within the table being accessed. 

 

Add new record tool is used to add a new blank record to the table you are working with. To copy an existing 
item to a new item, or to replace an existing item with a new number, enter the number directly into the item 
number field. You will then be prompted for the action you want to take. 

 

Delete tool is used to delete an existing record from the table you are working with. 

 

Ignore changes tool is used to undo changes that appear on the screen but that have not yet been posted. It 
will not undo changes that have been posted. 

 

Previous record tool is used to go back  to the previous record in the table you are working with. 

 

Next record tool is used to go forward  to the next record in the table you are working with. 

 

Send one record tool is used to send the modification made to the current record to the POS terminals 
immediately. This icon changes color to green when a modification has been made to a record. When the record is 
deployed the icon will return to the normal color displayed here.  Clicking the satellite will send the current record to 
the POS terminals whether a change was made or not. 

 

Save and close tool will save the current changes and close the table you are editing.  

NOTE: L-BOSS saves new data in a field once you press tab, enter or when you click in another field. Data is also 
saved when you access another record in the table, or when you open a new table. This means that you do not 

need to press the post tool 

 

after each record you modify, L-BOSS does it automatically for you. 
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Displaying search lists  

L-BOSS uses tables to store data. In some cases the information stored in a table has been indexed so that a rapid 
search can be performed to locate data you require. As you are navigating through the fields of different tables you 
will notice that sometimes a "?" (question mark) appears beside the cursor. This means that the selected field is 
indexed so that its contents are viewable as a searchable list. Double clicking the selected field will open a viewable 
list of the table's contents.   

The sequential order that the contents will appear depends on which field you have selected for the drop down list. 
For example, if you are editing accounts and double click in the account number field, the list is in numerical order 
according to the account numbers. Double clicking the account name field opens the same information, but listed 
alphabetically according to the account names. The data list's left column will contain the data from the field 
selected.   

Here is a sample of the account search window:  

  

When this type of list is open, you can have many search options. Clicking at the top of any column will use that 
column to sort the data. From the example shown above, if you click on the column header Company the list will 
sort in alphabetical order by company name. If you click again in the same column the list will sort again in 
alphabetical order starting from the opposite end of the alphabet. Click in the Acc # column header and the same 
list will sort numerically. Re-click the Acc # number and the list will sort from the last account to the first, etc. You 



L-BOSS Preferred shopper       

11       

can also use the locate entry window to type data. If you have sorted the column by clicking in the Acc # number 
field, the locate tool will search the Account number field. If you have sorted the column by clicking in the company 
field, the locate tool will search the item description field (F29 in the database.) You can sort all the other fields the 
same way by clicking that column header.  

You can also use this type of search window to perform a wildcard search (the field you are searching contains the 
data in a continuous string.) For example you want to search for all accounts that include the word BEST anywhere 
in the company name. Type the word Best into the locate window. The system will display the first account it 
locates beginning with the word Best. Press the Enh. Search button. The system will display every account that 
includes the word best. So the first list may show no results unless there are accounts that start with Best. But the 
second list would show Best Company, All the Best, etc.  

The File menu option in the search window allows you to send the data from the search list to an export file or to a 
printer. This is a simple way to print a very specific list: set a filter to find your items. The Apply button will produce 
this type of search list that can then be printed (or exported to a csv file.)  

The next major advantage to this type of list is that a customized query can be defined if you understand the LBoss 
database structure and you have a minimum knowledge of sql commands. Access the options menu and select 
custom query. The system will open up an sql editor window. Add the commands you need to select the data you 
want to list. If you are unsure how to do this it is recommended that you inquire with your dealer on how to add 
custom queries.   

Windows menu  

Like many Windows based programs, the Maintenance application allows you to have more than one window 
(table) open at the same time. The Window menu contains options that allow you to control how the windows or 
tables appear on the desktop.    

Cascade: This aligns the open windows in layers, with the corners and title bars of all open windows visible, 
enabling you to find the window you a looking for.  

Tile: This option tries to place all the open windows into the Maintenance application's desktop by re-sizing them.  

Close All: Closes all open windows at once.  

Selecting open windows from a list: If you have multiple windows open on the desktop, you can open the "Window" 
menu and select the window to "bring to front" from the list at the bottom of the menu.  
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Creating risk levels  

Dealing with customer charge accounts involves risks. There is the risk of allowing a customer to post a charge and 
then losing the revenue if the customer does not pay his account. There is also the risk of accepting bad checks 
from customers. The PS option does not allow you to use credit limits even if you set them. But you must 
nonetheless create at least one risk level. Just set the fields to 0 (zero).  

The Risk level table allows you to 
administrate risk levels where you set 
charge privileges and check payment 
privileges. An unlimited number of risk levels 
can be added to allow complete flexibility in 
determining what risk a particular customer 
represents for your business.        

Create as many risk levels as you need to manage your accounts. The number you assign here will be used to 
identify this risk level when you are creating client records.  

  

From the maintenance application 
main menu, access the Accounts 
menu and open the risk level table.  

Press the + icon to add a new risk level. 
Assign a description to the risk level record. 
Max credit: Use this field to limit the credit that will be available for this 
customer.  A client with a $200 credit limit and a current balance of 
$175 will be able to charge up to $25 more.  
Check limit: Enter the maximum check payment amount  for all clients 
assigned to this risk level. The check limit is the maximum you accept 
from this level for an individual check. 
Check change limit: Enter the maximum change you will remit to 
clients assigned to this level. 
Check week limit: Enter the quantity of checks the customer can use 
in one week in the first field and the maximum check payment amount 
in the second field. 
Accept check: This field allows you to determine whether customers 
on this level can pay by check. Double-click this field to chosse from 
1- Accept check 
2- Manager required 
3- Don't accept 
Interest rate: Enter the annual interest rate that will be charged to 
clients on this risk level for past due invoices. 
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Creating customer levels  

Storeowners often encourage their good customers by setting up a preferred shopper program. L-BOSS includes 
features that can be used to reward customers with immediate benefits or with incentives that accumulate over 
time.               

The Customer level table allows you to define shopper levels where rewards can vary by level. You can create 
multiple customer levels as required. Within each customer level record you assign a price level and / or a discount 
percentage. The POS will combine these 2 fields when the customer account is opened for a transaction.    

  

From the maintenance application main 
menu, access the Accounts menu and 
open the Client level table.  

 

Level Number:  Enter the level number you want to program.   

Description:  Enter a brief description of this customer shopper level 
(Regular, gold card, super-saver, etc.)  

Price level:  Enter the price level that members of this customer 
group will receive. Remember to create these price levels under the 
item related maintenance. You must enter a price level.  

Discount:  Enter the discount that members of this customer level 
will receive on discountable products. This field is not compulsory. 
The customer level discounts will apply to the transaction total without 
netting the item sales. If you are working with L-POS this default 
behavior can be changed and the discount will apply directly to each 
line item in the transaction. This change is made in 
PosSetup>System>Account.   
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Customer accounts  

L-BOSS allows you to create an unlimited number of records within the Client (or customer) table. Each customer 
account can have multiple sub-accounts or "Contacts" (account users), but must have a "main" user. Accounts 
must be linked to both a risk level and a customer level.  

 

Client number: This field is used to enter the 
number that will be used to retrieve the customer record 
in both the L-POS lanes and L-BOSS stations. Several 
considerations should be made when deciding on the 
account numbering system you will use. Although the 
field allows you to use alpha-numeric characters to 
identify the account, this becomes more of a problem 
when it is time to input the numbers on the POS: 
numeric only numbers are much easier (and faster) to 
enter. The client number can be up to 20 digits. 

 

Modified: The L-POS stations can be configured to 
allow the creation of customers "on the fly". The POS 
will prompt for the minimum information required to 
create the account, then send the new account to the 
back end. When a customer is created from the front 
end and sent to the back end, the dot beside "Modified" 
will be red, to identify accounts that were created in the 
front end, and probably need to be edited to complete 
the information. 

 

Detail: This option is available if your system is 
licensed to use the L-Tracker option. When you press the Detail button a new window will open and L-BOSS 
will begin processing the electronic sales journal files for the last 5 weeks, unless this has already been done. 
This will in turn create a list of all the transactions involving the account over that period. You can view details 
for previous periods by selecting the appropriate start date on the calendar. 

 

PAL: The pull-down field to the right will probably show PAL as the target group. The target allows you to 
specify, in multi-store environments, which programming zone this data will be sent to. In single store 
applications this should show PAL for all accounts. If you only want customer X to be sent to store 5, you would 
create a program target for store 5 and put that target on client record 5. Note that the client account file is 
different than the PLU file. You may have multiple targets for items. This means the item is really in the file 
several times, one programming set-up for each target. Each account can only exist once, you cannot have the 
same account with multiple targets. 

 

Company: Enter the company if required. 

 

Address, City, Prov/State, Code and Country entered here will be displayed on account statements or other 
customer based reports. L-BOSS also provides a statement report that prints the address so that it can be 
folded and sent in a standard "windowed" envelope. 

 

Expiry is the date until which this account remains active. People who charge membership fees should set 
the date when renewal is due for this account. The renewal date can be modified here by changing the date or 
through the L-POS if certain options are set. See the related programming in PosSetup>System>Account. 

 

Phone and fax are used to enter the telecommunications data for the customer. Because of international 
considerations no formatting is done in these fields. 
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Card # and Exp: Use these fields to record customer credit card information. This information is provided 

as information and it is not used by the system automatically. For example, you may have an agreement with 
your customers that you can automatically invoice their credit card account when a rental item is lost. 

 
Tax 1 Exempt and Tax 2 Exempt should be entered if you want the L-POS front end to exempt taxes that 

would have applied to the items in the transaction. These are individual flags. You do not need to exempt one 
tax for the other tax to be exempted. 

 

Note: L-POS can use up to 4 tax rates. You may enter a Tax 3 Exempt by clicking on the descriptor for Tax 
1 Exempt. A window will open where you can record the tax 3 exempt number. You may enter a Tax 4 Exempt 
by clicking on the descriptor for Tax 2 Exempt. A window will open where you can record the tax 4 exempt 
number. 

 

Group is used by the report system to filter the customer file and only produce a report for the category 
selected. It is not a compulsory field. For example, you want account statement reports for certain customers 
every 30 days while other customers are never sent a statement. You could type 30 days in the group field for 
the first customers and never in the other group. Then when you want to print the statement reports you would 
filter by group "30 days." Once entries have been made into this field you will be able to click in the field to 
choose from the existing data entered into other customers. 

 

Balance is the current online charge balance for this customer. 

 

Points are the customer point amount that has accumulated. 

 

Risk Level: Select the proper risk level assigned to this account. The risk level controls both store charge 
and check cashing privileges. The risk levels are created in the Client risk table programming. 

 

Client level: Select the proper customer level used by this account. The customer level may offer a discount 
or a price level other than the default price. This is set up in the Client level programming under the Account 
menu. 

 

NOTE: The Risk and Customer level tables should be programmed before creating accounts in the system, 
making it easy to select both Risk and Customer levels from a pop-up list. 

 

Contact Required: Set this option to on if L-POS should require the contact number to be entered along 
with the account number. Account statements and other account reports will show information from all contacts 
for the account as a single account. To be able to track each contact's transaction information, the contact 
number must be included when entering the account number at L-POS lanes. L-POS lanes can be set to 
require the contact number by setting the "Contact Required" flag on. 

 

PO # required: This flag will force the entry of a purchase order number whenever this account tries to 
make a charge. 

 

PO# Digits Min/Max: Set the minimum and maximum number of digits allowed for PO # entry for accounts 
with a PO# required.  

Deleting and Modifying Account Numbers  

L-BOSS will not allow you to modify an account number, or delete that account if there is an account charge 
balance. Before trying to delete or modify account numbers, set the balance to zero (see the "balance" option in the 
client table). If an account number is modified or the account is deleted, past transactions will still appear on reports 
for that period. If you create a new account with a previously used account number, past transactions viewed in 
reports for that account will show as if they belong new account.  

NOTE: Payments made to accounts on the POS terminals do not

 

apply to specific transactions. Amounts received 
as payment on accounts apply to the previous balance. 
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Customer contacts  

Customer records require that contact information be entered. The contact is the person using the account. Each 
customer must have a main contact and may have as many additional contacts as required. This in turns provides 
both the customer and the store with information on which contact used the account for a given transaction.  

Each account must have

 

a "main" contact. Additional account users (contacts) can be added using the "+" button, 
or removed using the scissor button from the tool bar in the contact section. The left and right arrow buttons are 
used to move to the next / previous contact.  

 

Number: This field contains the contact's 
number, assigned to a contact when it is created. A 
contact number may be required along with the 
account number at the POS to use the account if the 
"Contact Required" flag is set to on. If no contact 
number is entered, the transaction will be linked to 
the "main" contact. The "main" contact always 
appears as the first contact. 

 

First name: Enter the contact's first name. 

 

Last name: Enter the contact's last name. 

 

Language: This field allows you to set the default 
language the system will display for this customer, English or French. L-POS will print receipts based on the 
customer's default language. Account statements will also print using the default language. 

 

Extension: Is the contact's office telephone extension. 

 

Birth: Enter the contact's birth date. If entered it will be used to validate age-restricted items. 

 

Home: This field can contain the contact's main telephone number, pager, or other number. The title to the 
left of the field is in red, and can be modified by clicking the title and entering the phone type. (In the example 
shown above, the title is "Pager"). Note: This field can be used to store additional checking account numbers 
for this customer. On check transactions the POS will verify the main account number, and all contacts of that 
account home phone number field for a matching check account number. So if you get a bad check from the 
customer you can refuse checks from all his accounts this way without creating more account records. You only 
need to add contacts and place the check account number in the home phone number field. By adding 
additional contacts you will be able to store as many bad  check numbers as required per account. 

 

Cellular: This is an alternate number for the contact. 

 

Email: This is the contact's email address, entered here for office reference only. 

 

Remark: This is a per-contact message that can be programmed to appear on the POS display when this 
account contact is used. 
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Then icon in the contact table 

opens a window where you can add 
contact specific information into 5 text 
fields. Use these fields to build reports as 
required. The fields can contain 
information such as driver’s license, 
favorite wine, or anything else you may 
need to track for your accounts. The field 
titles are info field 1 to info field 5 by 
default. These screen labels can be 
changed by opening the L-BOSS 
configuration menu and accessing the 
Advanced flag settings. Here is the 
contact table extra info fields window. 

          

Note: If the current cashier's phone number matches the account phone number or the account contact phone or 
cell number the transaction will not be allowed. This is to prohibit cashiers from using their own account to sell to 
themselves or to others with their own account discount. If you want a cashier to be able to sell something to his 
own account you must ensure the phone number of the cashier is different than the phone numbers of the account 
contact. 
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Associating a Photo with a Customer contact  

L-BOSS and L-POS can also be configured to display a photo of the customer, ideal for visual confirmation. The 
photo can be for office use only, or also sent to the front end. The POS screen must be programmed to display the 
photo when the account number (and contact number) is entered at the POS.  

NOTE: When the customer table is being edited 
the Menu bar is modified to include a View 
option.   

This is where you can toggle on or off the displaying of the customer photo on the maintenance screen. Click the 
"View" menu from the Maintenance top bar menus select the "Picture" option. The customer table window expands 
to display a picture box, with "Browse" and "Delete" buttons.       

The naming convention for the 
customer id photo is fixed to allow 
quick lookup of the photo within 
the POS application. L-BOSS and 
L-POS can display either bmp or 
jpg files. The filename must be 
"cltxx-y.jpg" where xx is the 
account number (set to the same 
value as the actual account 
number) and where y is the 
contact number. By way of 
example, for customer 101 main 
contact the photo filename must 
be "clt101-0.jpg". Whenever an 
image is selected and the 
filename does not meet the 
naming convention rules it will be 
copied or renamed to the correct 
name by the application. 

Use the Browse option to 
locate the contact's photo file 
or Delete to remove the 
associated photo. 

The View menu
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Adjusting account balances  

L-BOSS allows you to perform an account adjustment to modify the current house charge balance or the current 
points balance. This may be required if you are beginning use of L-BOSS and have existing charge balances for 
customers. Of course the account balance does not refer to systems that are not licensed for the Account 
receivable option.  

Find the account you want to make the adjustment for. Press F4 and the following window appears:                  

Custom messages for statements   

Use this option to modify the 
messages that are printed on 
account statements issued from the 
L-BOSS reporting system. Unless 
you are using the A/R option you 
probably do not need to print 
statements. 

Amount: You can increase or decrease the 
customer balance by pressing either the + or the 
- and entering the adjustment amount in the 
window. This will in turn create a transaction to 
update the charge balance for this customer. 
Points: This field displays the customer points 
that have accumulated. You can increase or 
decrease the points balance by pressing either 
the + or the - and entering the adjustment 
amount in the window. This will in turn create a 
transaction to update the point balance for this 
customer. 
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Account Discount table  

The account discount table is a convenient method to assign discount rates to all items in each sub-department per 
customer type. This means that you set a different discount rate for all health and beauty products for customer 
assigned to levels 1, 2 and 3. And another discount structure for items in the baby category for each customer type. 
The discounts assigned in the discount table will be applied on a per-item basis, meaning the PLU revenue will be 
net after discount is removed. The discount total is reported as a statistic on the financial report.  

Open the Account menu, and click on the Discount table.  

  

From L-BOSS open the Maintenance application, then select 
the Account menu, and click on Discount.
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The discount table in the next window shows the discounts given to regular customers for all items attached to sub-
department 50.  

  

MPF1: The MPF1 is used for different needs according to the store. In this case it can be used to differentiate the 
discount rate assigned to products in the same sub-department.  
Sale: The Sale flag applies to all items that are being sold at any price other than the regular price. Items placed on 
sale, or items in a Promo batch, will use the discount rate set in the rows where Sale is set to Yes.  

Creating records in the discount table:  

Enter the sub-department number and client level you want to assign discounts for. When you double click in either 
field you will not see the list of sub-departments. You will see the list of sub-departments that were assigned in the 
discount table. If you want to search for a sub-department you need to right-click in the field.  

MPF1 Sale You need to set a discount rate or cost plus factor for each of the possible conditions:  

No  No  All items that are not programmed with the MPF1 and not on sale.  

No  Yes  All items that are not programmed with the MPF1 flag and are on sale.  

Yes  No All items that are programmed with the MPF1 flag and are not on sale.  

Yes  Yes  All items that are programmed with the MPF1 flag and are on sale.  

Send the discount table records to the POS terminals by clicking the satellite or by selecting Deploy all changes 
from the L-BOSS tasks menu.  

Sub-department 

Client level 

For each sub-department and client level you can assign 
up to 4 different discount rates. This setting will apply to all 
items attached to the sub-department, assuming the items 
have not been given the prohibit discount status. 
The discount rate will be removed from the price attached 
to the client level you are programming, unless you select 
the Cost flag. Then the % you assign will be added to the 
cost. 
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Assigning preferred shopper points  

Points can be issued different ways: 

 
Per item in the PLU file 

 

Based on the sub-department 

 

Based on the department 

 

Based on tender (payment buttons) 

 

Manually  

Points that are issued per item on the PLU file can be given as a fixed value or as a percentage of the item price. 
This decision must be made in PosSetup>System>PLU tab under Points as a percentage. This flag affects all PLU 
items. All other points are issued as a percentage of the transaction amount.  

Assigning item based points:  

Access Maintenance>Item>Price tab:  

 

Each item you create can be given a specific number of points. In this 
example, if points are assigned they will be calculated as a percentage 
of the item price. To issue points as a fixed amount for PLU items you 
must modify the setting in PosSetup>System>PLU. Change the setting 
for Points as percentage by de-selecting the option.  

Points can be assigned per price level, and a different points value can 
be entered for items on sale or items placed in a batch. 
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Assigning points to sub-departments  

Open the sub-department table from the Maintenance program.  

  

Points assigned to the sub-department records are always calculated as a percentage 
of the item price.  

 

Items attached to the sub-department will all be part of the points calculated in the 
transaction. So if you sell 3 items attached to the Bakery sub-department for a total of 
$5.50, 550 points will be issued. 

 

An item can be attached to a sub-department that issues points. The same item can 
also be programmed to issue points by assigning them in the price table of the PLU record. 
In that case points will be calculated on both. This is one way to issue bonus points above 
the normal points usually offered. 

 

For example, bakery items give 100% points as in our example. You would like Muffins 
to give a fixed 25 bonus points above the normal points issued in the transaction. Make 
sure you do not select the flag to issue points as percentage in PosSetup>System>PLU 
settings. Then assign 25 points on the Muffin PLU. 
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Assigning points to Departments  

If the POS keyboard uses departments you may also decide to attach points to the department file. Follow the 
same procedure as you did to add points to the sub-department file.  

Assigning points to the tender functions  

If you prefer to assign points on the sale total based on tender function you need to access PosSetup>Buttons & 
Forms.    

                 

Locate the first tender function that you want to assign points to. 

Click on the serial number and select Buttons & Forms from 
the pull-down menu. 
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Repeat the same procedure for each tender that should issue points. 
Manual points function 
From PosSetup>Buttons and forms locate or create a Manual Points button using function 317.  

Assign the points value 
to be issued for amounts 
paid with this tender.
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Function 317 can be used to issue points or to redeem points.  

 

“No Minus” controls the total points that can be redeemed when this key is used with the negative flag. If 
you set “No minus” to Yes, you will not be able to receive more points than the customer has on account. If you 
do not set this flag to Yes it will be possible to receive any amount of points from the customer. 

 

“Negative” controls whether this points function will issue or redeem points from the customer. 

 

“Current points” is used with the negative flag. If you are redeeming points you need to decide whether 
points issued in the current transaction can be redeemed immediately in the same transaction. Set this to No to 
prohibit redeeming points given in the same transaction.  
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Sending the account files to L-POS  

   

The "Transfer" menu is only visible if the account tables are opened for editing. After editing information in a table, 
you can send the modifications either by using the satellite dish button on the edit table toolbar, or from the 
"Transfer" drop down menu. The "Transfer" menu allows you to send the currently selected record or the entire file. 
In most cases sending the entire file is not suggested or required, but doesn't really cause any problem.    

When you need to send one account record to 
your front-end terminals the quickest way is to 
locate the record in the account maintenance 
module and click the satellite. This will send 
the all the information related to that account 
including the customer record, the contacts, 
the image files, the risk level information and 
the customer level information. Click the 
satellite and the following window will appear: 

  

Select Yes to send the current 
account to all terminals. 

 

Select No or Cancel to abort 
the procedure. 

 

Select All to send all accounts 
to all targets.
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Sending account related files manually  

  

From the list of files that opens you need 
to select one or several files. Click any 
file to send it to a specific target. To send 
multiple files proceed as follows: while 
holding the CTRL button on your 
keyboard click on several files. The 
accounts need CLC_TAB and the 
CLT_TAB. To replace the existing files 
on the POS terminals place a check 
mark in the Replace field. (You may 
need a higher access level, if so contact 
your dealer) When this is done press the 
Deploy button.  

It may be necessary to send specific account file data to 
the POS terminals. When this needs to be done open 
L-BOSS>File>Deploy individual file
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Note: You may also need to send the risk levels or the customer levels to 
the POS terminals. Return to step one where you selected CLC_TAB and 
CLT_TAB. Select CLR_TAB (risk table) and CLF_TAB ( shopper level). 
Then follow the same steps to deploy to the lanes. 
Note 2: You may not be authorized to select Replace when you deploy 
individual files. The difference between deploy with replcae is that the files 
you are deploying to the target machines will be erased when Replace is 
selected. All existing data will be replaced. Otherwise the new data you 
send will be merged to the existing data.   

Note: If you are using points you need to send the items, sub-departments, tender functions, or other changes 
made to the front end to activate those changes on the POS terminals. If you are using the discount table you will 
need to deploy those records to the POS terminals as well.  

Special points features  

L-POS also includes several advanced flags related to points tracking. Among these options 
display points as dollar amounts 
Set a block size where accumulated points are converted to available spending amount 
Set a redeem ratio for points issue and redemption  

To modify the normal points tracking method you need to define a special account identifier. This is a prefix that 
must be added to each customer you create in the account file. For example, the account prefix could be B, BAR, 
or any other character. When this setting is made L-POS will display and track additional fields related to points 
issuing.  

Open Pos-Setup, System, Advanced programming to set the Special account prefix. Look in the “vendor’s 
specific” section at the end of the options list. Enter the value your system will use as the account prefix. 
Remember that each account must start with the prefix.  

Once this change is made several fields from the Advanced preferred shopper options will be used: 

 

Subtract redeemed points from issued points: Subtract redeemed points from the current transaction from 
the issued points of the current transaction, 

 

Points rounding factor. Set the points rounding factor. 

 

Point identifier symbol used on receipt to identify product: Symbol to print before the item price on items 
that issue points. 

Once you have selected Deploy a list will appear with the available 
targets that should be waiting to receive the data files. Select the target 
(normally PAL). Selecting PAL means the data will go to all the terminals 
included in the PAL target terminal group. This means that the data will 
be sent to all terminals. If you want to send the data to only one terminal 
select the programming target that includes only that terminal. 
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Suppress PLU attached points when item discount is used: Answering FALSE will give points on the full 

price of the item before discount 

 
Spending block size: This value is used to calculate the available spending points on the receipt. For 

example, every time you acquire 10,000 points they get converted to available spending. If you need to 
accumulate 2500 points to be able to spend them then enter 2500 as the spending block size. Once this 
amount of points is reached the accumulated points will be reduced by that amount and the Available spending 
value will be increased. The available spending will increase in pro-rata to the value set in Spending value. 

 

Spending value: Enter the conversion rate used from accumulated points into Available spending. For 
example, if you need to acquire $100.00 of purchases (10,000 points) to be able to spend $10.00 of reward 
points, the spending value would be .1 (one tenth). If you need to acquire $100.00 of purchases to spend $5.00 
of points the field should be set to .05 (5%). 

 

Custom REDEEMED POINT message: Enter the receipt descriptor for printing the Points Redeemed 
during the transaction. 

 

SPENDING AVAILABLE custom message: Enter the receipt descriptor for printing the Points available to 
spend.  
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L-POS setup  

System settings 

             

Several decisions must be made before you begin using 
customer accounts on L-POS. Access the 
PosSetup>System>Account tab. This can be done from the L-
POS transaction screen and selecting System from the pull-
down menu. 

Click the serial number to view the PosSetup menu
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You can also start Pos Setup from the C:\Poswin folder of any lane by running the PosSetup.exe program from 
that folder.                            

Print options        


